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From now on, the pictures of all installation procedure and contents will be explained 

on basis of ioi 353. In case of other model, the images included in instruction may be 

different.  
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Installation 
 

 

1. System Environment for Installing and Working This Program 
 

1) To run this program smoothly, computer environment specified below is required. 

① CPU: Pentium III, 600 MHz or more 

② MEMORY: 128M or more 

③ Monitor Resolution: 1024×768 

④ Operation System: WINDOWS 2000, XP, 7 (x86,x64), Vista (x86,x64) 

⑤ USB port for communication 

 

2) Things needed to install this program 

① PC which is to be connected with body composition analyzer 

② Program installation CD - Installation CD offered with body composition analyzer 

③ Equipments for communication - USB cable (cable) 
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2. Body Pass Installation 
 

1) Put the program installation CD in CD-ROM drive. Check the contents in the CD-ROM. 

 

 

2) Program installation is started by double click of the BodyPass.msi file in the installation CD. 
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3) When “BodyPass Setup Wizard” window appears, click “Next” button. 

 

 

4) When the window changes like below picture, click “Next” button. 

 

 

5) When the window changes like below picture, click “Next” button. 
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6) When the window changes like below picture after installation, click “Close” button then 

installation is completed. 

 

 

7) After program installation is completed, BodyPass(ioi 353) short cut icon is created on the 

desktop and this program is added in the list that appears when you click “Start” button at the 

left bottom of window, start > BodyPass(ioi 353). BodyPass program can be executed through 

the icon or the list. 
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3. USB Driver Installation – Body Composition Analyzer 
 

This is how to install the driver for USB port of body composition analyzer in order to use it when 

a computer is connected with the body composition analyzer. 

 

1) Connecting USB cable 

Connect the USB port in the rear panel of body composition analyzer and a USB port of a 

computer with the USB cable offered by our company. 

 

 

2) A mesesage appears that indicates a new hardware is added and “Found New Hardware 

Wizard” window below appears. 

Put the BodyPass program CD in the CD-ROM and choose “Install from a list or specific 

location (Advanced)” then click “Next” button. 
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3) When the window changes like below picture, choose “Include this location in the search” 

and click “Browse” button. 

 

 

4) When “Browse For Folder” window appears, choose “USB driver” folder in BodyPass 

program CD and click “OK” button. 
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5) Confirm that the folder chosen at step 4 is assigned like below picture and click “Next” button. 

 

 

6) The window like below picture appears and “USB driver” is searched and installed 

automatically. 
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7) When the window like below picture appears, click “Continue Anyway” button. 

 

 

8) When the window like below picture appears after installation, click “Finish” button. 

 

 

9) After USB<->Serial driver is installed, “Found New Hardware Wizard” is executed again and 

starts installing USB Serial Port driver. This is repeted 2 ~ 4 times. 
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10) After all installation needed is completed, 

click start à Setup à Control Panel à System à Device Manager à list   

It is checked that “USB Serial Port (COM3)” is added by double-clicking “Ports (COM & LPT).” 

(Port number can be assigned as another number.). 

 

 

11) If you want to change port number, double-click “USB Serial Port (COM3)” then the window 

like below picture appears. Click “Port Settings.” 
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12) Then the window changes like below picture. Click “Advanced...” button. 

 

 

13) The window like below picture appears. Choose “COM port number” and click “OK” button. 

(COM2 is used in this manual.) 

 

 

14) After port number change is completed, communication is possible between the body 

composition analyzer and the computer when they are connected through USB cable. 
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Notice  

In case “Found New Hardware Wizard” wizard does not appear automatically, 

Place the mouse on “My Computer” icon of desktop and click the right button of the mouse 

then pop up menu is opened. Click “Properties” then the window like below picture appears. 

 

① Click “Hardware” tap.                   ② Click “Device Manager (D)”. 

 

 

③ When “Device Manager” window appears, click the right button of mouse then pop up 

menu is opened. Open wizard window by clicking “Scan for hardware changes” and 

start installing from the beginning. 
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4. Installing USB Driver-Lifecorder 
The way to install USB driver in order to use a USB terminal when connect with Lifecorder and 

computer. 

 

1) Connecting USB cable 

Please connect the terminal at the side of Lifecorder and the terminal of computer using USB 

cable provided from our company. 
 
 
 
 
 
 
 
 
 
 
 
 
 
2) ‘Found New Hardware Wizard’ window shows with an additional message as follows. 

Put Body Pass program CD into CD-ROM and check the ‘Install from a list or specific location 
(Advanced)’ and then click the ’Next’ button. 
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3) When the window like below shows, check the ‘Include this location in the search’ and press 

the ‘Browse’ button. Please choose ‘Local Disk(C:) ->Windows ->System32’ and click the 

‘Next’ button. 

 

 

4) With the window as below, USB driver is searched and installed automatically. 
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To connect our Body Composition Analyzer and Lifecorder with PC, two USB ports of user PC 

are necessary. (One connects Body Composition Analyzer and the other connects Lifecorder.)  

When user PC doesn’t have enough USB port, need to use USB herb equipment.  

In this case, the Lifecorder should connect with PC directly not USB herb.  

Because Lifecorder uses a power source of PC in order to transfer data.  

5) If the window shows as below, press the ‘Finish’ button then the installation is finished.  

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

notice 



 

- 17 - 

Body Pass manual 

Deletion 
 

 

1) When deleting this program, data backup should be done before deletion. (Refer to p.18 

about how to back up.) 

 

2) Click “start → Setup → Control Panel → Add or Remove Programs.” 

Choose “BodyPass” in the list of installed program and click “Remove” button. 

 

 

3) When the window below appears, click “Yes” button. 

 
 

4) The window appears that displays execution of program deletion. This window is closed after 

program deletion is completed. 
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Data Backup & Restoration 
 

 

1. Data Backup 

 

Because any problem occurs to the computer in which BodyPass program was installed and 

has been used up to now or there is some other reason, if this program need to be reinstalled 

you should back up all measured data stored in the computer before reinstallation. 

 

1) Copy “My Computer → local disk(C:) → BODYPASS(ENG) folder → DATABASE folder”. 

 

 

2) Make “Data Backup” folder at any location you want and paste the “DATABASE” folder copied 

in the “Data Backup” folder. 
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2. Data Restoration 

In order to check previous data after reinstalling BodyPass program (refer to p.4 about how to 

install), you should restore the back up data. 

 

1) Before restoration, you should execute BodyPass program and exit it. 

This is because program-related files are created when BodyPass program is executed. 

 

2) Copy the back up data (DATABASE folder) in Data Backup folder you made. 

 

 

3) Overwrite the DATABASE folder in “My Computer → local disk(C:) → BODYPASS(ENG) 

folder”. 
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How to Use Body Pass 
 

 

1. Log-in 

 

Below picture is the first screen that appears when BodyPass program is executed. 

Input the ID and the password given to you and click log-in button. Then the main screen of this 

program appears. 

 
 



 

- 21 - 

Body Pass manual 

2. Registering, Modifing, and Deleting Member 

 

After log-in, the main screen like below picture appears. 

 
 

1) Member Resistration 

Input personal information of a member and click “Save” button. 

You should input ID number, gender, name, date of birth, and height of the member. 

 

① ID number: input the ID number of a new member. ID is proper number to the member 

therefore cannot be duplicated. If ID number is duplicated, you will see the warning 

window that tells you the ID number is duplicated. 

② Name: input the name of the member. 

③ Gender: check the gender of the member. 

④ Birthdate: input the date of birth of the member. 

⑤ Telephone: input the phone number of the member. 

⑥ Height: input the height of the member. 

⑦ Address: input the address of the member. 
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⑧ Activity: choose one according to the amount of daily activity of the member. This is 

applied to total energy expenditure calculation of the member and is composed of five items. 

⑨ E-mail: input the e-mail address of the member. 

⑩ LC CPU No.: When connect member’s Lifecorder, indicate the proper CPU No. shows. 

    Deleting data: Lifecorder data are deleted. 

    Lifecorder data: Move to ‘Lifecorder information’ of Lifecorder 

(Refer to page 53 for more explanation) 

⑪ “Save” button: after inputting basal information of the member, click this button. Then the 

information appears on the right part of the screen and you can confirm the member 

information is registered. 

 

2) Member Modification 

Click a member you want to change personal infofrmation in the right list then the member’s 

data is displayed under “Information” button. After modifying the items you want to change, 

click “Modify” button then the member’s data is changed and displayed again in the right list. 

 

 

 

 

 

 

 

 

 

3) Member Deletion 

Like modification, click a member you want to delete in the list then click “Delete” button. 

When the confirmation window for member deletion appears, click “Yes” button then the 

member is deleted. If you delete a member, all measured data of the member are removed 

and it is not possible to restore the data. 
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3. Searching Member 

 

1) Individual Member Search • Deletion 

 

① Individual Member Search 

Place the mouse on any part of the right list and click right button of the mouse then pop up 

menu appears for “Search option/Delete”. 

There are ID and name in search option. Input ID or name of the member you want to 

search then the member’s information is displayed. 

(Search option can be chosen by clicking  button beside “Member list” button.) 

If you want to see the latest measured result of the member, click “Measure reult” in the 

menu buttons. 

If you want to see measurement list of the member, double-click the member. 

 

 

② Searched Member Deletion 

Member deletion is possible through member search. 

Place the mouse on any part of the right list and click right button of the mouse then pop up 

menu appears for “Search option/Delete”. 

It is possible to delete the data of searched member or the entire member. 

When you choose “Delete,” confirmation window for deletion and if you click “Yes” in the 

window, member information is deleted. 
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③ Searched all member 
  Whole measuring data indicates on the member list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 ④ Clear member list 

The member information is not indicated on the list. 
If you select ‘searched all member’ you can see the member information again. 
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2) Entire Member Search 

Click “Entire member list” ( ) button on the right side of the main screen then the 

entire member search screen appears like below picture. 

  

 

 

 

 

 

① Place the mouse in the middle of the screen and click right button of the mouse then pop 

up menu appears. Choose “Member search” then search option window appears. Or click 

“Search option” button between the two tables then search option window appears. 

② Select ‘All member’ or assign measured date you want to search in the search option 

window and click “Search” button then the searched member appears in the upper table 

like below picture. 

 
③ When you click a member in the upper table, measured information of the member is 

displayed in the lower table. 

④ When you double-click one in the lower table, result sheet of the measurement appears. 
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4. Setting Communication Port  

 

This is to set communication port between the body composition analyzer and BodyPass 

program. 

 

1) Click “Function → Selecting port” in the 

menu bar of upper left part of the main 

screen or “Connect port” button in the 

menu buttons. Then the window like 

below picture appears. Click “Port scan” 

button. 

 

 

2) Available ports are searched and 

diaplayed. 

 

 

 

 

 

3) Double-click the port connected with the 

body composition analyzer then 

“CONNECTION OK!!!” appears. 

 

 

 

 

4) Click “Apply” button in the window then confirmation window for chosen port. Click “OK” 

button in the confirmation window then communication connection is completed. 

Body Pass shows the state of applied communication port at the right bottom of the main 

screen. 
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5. Making and Transmitting Logo   

 

Logo is printed on the upper right part of result sheet. 

Logo is printed as black and white from body composition analyzer but can be printed with color 

when printing is done through BodyPass program. 

 

1) Click “Function→Making logo” in the menu bar of upper left part of the main screen or “Make 

logo” button in the menu buttons. Then the window like below picture appears. 

 

 

 

2) Menus in LogoMaker are as follows. 

 

① File 

a. New: this is to make a new logo. 

b. Open: this is to open existing logo or an image file. 

c. Save: this is to save the logo newly made. 

d. Print: this is to print the logo image. 

e. Close: this is to close the logomaker window. 

 

 

 

② Edit 

a. Undo: this is to cancle what has done right before. 

b. Redo: this is to restore what has been canceled right before. 
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③ Format 

a. Background color: this is to choose the color of background. 

b. Color: this is to choose the color for letter or line. 

- It is possible to choose color from the color table at the bottom of the Logo Maker 

window. 

- Color selection window appears by clicking “Format → Background color or Color” or 

double-clicking the left side of color table at the bottom of the Logo Maker window. 

Choose the color you want and click “OK” button. The color is applied to following job. 

 
c. Font: this is to choose style, size, color, etc. of the letter for logo. Font window appears 

by clicking “Font.” Choose the items you want and click “OK” button. The font is applied 

to the letters for making logo. 
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3) Menus in the tool box are as follows. 

 

 Selecting area for location change  Filling 

 Picking specific color  Eraser 

 Drawing with pencil  Inserting text 

 Air brush  Drawing arrow 

 Drawing line  Drawing rounded rectangle 

 Drawing rectangle  Drawing polygon 

  Drawing circle  Drawing with brush 

 

 

4) Example of making logo 

Let’s make the logo on the right. 

 

 

 

① Click blue in the color table at the bottom 

first and click rectangle in the tool box. Then 

draw a rectangle in the canvas. 

 

② Open the Font window by clicking “Format 

→ Font.” In the Font window, choose 

Tahoma, Bold, 14, and red color and click 

“OK” button. 

 

③ Click  (Text) button first and click the point you want in the canvas then cursor appears. 

Enter “Jawon Medical.” 
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④ In order to move the text to the center, click  (Select Area) button in the tool box. Place 

and drag the mouse around the area you want to move then dotted line appears as 

rectangle. Move this rectangular arear. 

 

* Click start point of the area you want to move with left button of the mouse and drag the 

mouse to the end point without releasing the left button. 

    

 

* Click the rectangular area marked with dotted line with left button and move the mouse 

without releasing the left button then the area is moved. 

    

 

⑤ Open the Font window by click “Format → Font.” In the Font window, choose Tahoma, 

Bold, 12, and black color and click “OK” button. 

 

⑥ Click  (Text) button first and click the point you want in the canvas then cursor appears. 

Enter “82-2-587-4056.” 

If you want to change the location, do it in the same way as shown in ④. 

 
 



 

- 31 - 

Body Pass manual 

⑦ After logo is made, click “File → Save” in the menu bar on the upper left side of the Logo 

Maker window then the logo is saved and converted to the image trasnmitted to the body 

composition analyzer. 

 
 

5) How to transmit the logo to the body composition analyzer 

Click “Transmitting logo” button in the Logo Maker window then the Logo Maker window is 

closed and “Transmitting logo file” window appears. (Transmitting logo file window also 

appears by clicking “Transmit logo” button in the menu buttons of the main screen.) 

When logo transmission is completed, the body composition analyzer sounds like tinkle and 

completion message appears in the Transmitting logo file window. 
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6. Transmitting Member  

 

Transmit the information of the member who is to measure body composition to the body 

composition analyzer. 

Click the member in the right list of the main screen first and click “Transmit member” button 

then the window like below appears. When memeber transmission is completed, the body 

composition analyzer sounds like tinkle and completion message appears in the window. 

 

 

 

 

7. Receiving Data from Body Composition Analyzer 

 

Body composition analysis data are displayed on the main screen when measuring is 

completed after member transmission. 
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<Data reception using USB memory> 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1) Data reception  

Insert the USB memory which is saving of measuring data to PC then indicate some messages 

like above picture with icon of USB memory.  

During reception of data if you press ‘cancel’ button, stop receiving the data and not saving.  

If you double click the USB memory icon ‘ ’ indicate some messages like above picture 
and save the data.  

 

2) Complete to receive of data  
When complete to receive from USB memory, the measuring data from main device indicates to 

the member list.  

The member name, which is from USB memory USB, is saving as USB Member and if you want 
to amend, please refer 22nd page “Member modification” 
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How to save the data to USB Memory   

 

1) Select ‘FLASH MEMORY’  

① Connect the USB memory stick on USB port on the 

back side of the device. 

 

② The window will show ‘Do you want to write data to USB memory stick?’ on initial screen like 

picture. Press YES (‘BACK’ button) to send data to USB memory. 

 

③ Transmitting window will be displayed on the screen. When transmission is completed, the 

message ‘saved’ will be shown. Press confirmation (‘BACK’ button) to complete the saving 

process. 

 

     

 

 

 

2) Select ‘USB MEMORY’   

In case of ‘USB MEMORY’, there is no message but in each measurement, it is saving to 

USB Memory.  

When you measure, you have to insert the USB Memory in the first screen of device. 

Otherwise if you don’t insert the USB Memory, there is an error message and can’t save the 

data. Therefore you should insert the USB Memory and measure again.  

 

* On the ‘System setup’ of main body, the “ID USAGE” must be setting as “YES” and in case of 

selection of each method then save the data with same method.  
* If there is no saving data on the FLASH MEMORY, if you select ‘YES’ on the screen above 

picture, indicates “No saved data”. After measuring of body composition analyzer, insert the 

USB Memory. 

 

 

 

 

 

 

 

NOTE 
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When connect the Lifecorder with PC having Body Pass program by USB cable, receive the 
Lifecorder Data. 
  
1) Connecting new Lifecorder 
It is connecting with new Lifecorder or an initialized one. 
 
① When do not register for member on Body Pass 

a. When connect new Lifecorder, appear the window as follows. 
In this case, doesn’t register as member so press the ‘No’ button and then register for 
member on main screen.  
(Refer to page 21 for registering of member) 

 
 

b. After member registration, please ‘Transmit member’ and measure the Body Composition. 
When receive the data of body composition, appear the window as below. Then press the 
‘Yes’ then upload the measuring data to the connected Lifecorder as follows.  

 
 
c. If appear below window, press the ‘OK’ button. Then it is completed to upload the 

measuring body composition into the Lifecorder.  

 
 
 
 
 
 
 

8. Receiveing Lifecorder data 
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② When member register is already done in body Pass but there are not data of Body 

Composition Analyzer 
a. When connect new Lifecorder, appear the window as below. Member register is already 

done, so press the ‘yes’ button. 

 
 
b. If the following picture shows, choose the member to use the connected Lifecorder. Enter 

the member’s ID or name and click the ‘Member Search’ button. 

 
 
c. If searching member shows, choose relevant member and press the ‘Selecting member’ 

button. 

 
 

d. When appear the ‘Selecting Lifecorder Member’ window as below, press the ‘Yes’ button. 
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e. As there are not measurement data of Body Composition Analyzer, following window is 

appeared. Close the window by pressing the ‘OK’ button. It is necessary to upload Body 
Composition Analyzer’s data to Lifecorder so must measure Body Composition Analyzer 
first.  

 
 

f. Doing ‘Transmit member’ of relevant member and measure Body Composition. When 
receive measurement data of Body Composition Analyzer, appear the window as below. 
Press the ‘Yes’ button then the measurement data are uploaded to the connected 
Lifecorder. 

     
   

g. When appear the window as below, press the ‘OK’ button. Then it is completed to upload 
the data of Body Composition Analyzer to the connected Lifecorder. 

 
 
 
 
③ When member register is already done in Body Pass and there are data of Body 

Composition Analyzer 
a. When connect new Lifecorder, appear the window as below. Please press the ‘Yes’ button 

since member register is already done. 
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b. When appear the window as below, choose the member to use the connected Lifecorder. 

Enter the member’s ID or name and press the ‘Selecting member’ button. 

 
 
c. If searching member shows, choose relevant member and press the ‘Selecting member’ 

button. 

 
 
d. When appear ‘Selecting Lifecorder Member’ window as below, click the ‘Yes’ button. 

 
 
e. When appear the window as below, press ‘Save’ button. 

Latest data are uploaded automatically to the connected Lifecorder.  
Lifecorder doesn’t have data actually but with upload, daily data are made so the message’ 
Data download’ shows. 
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  f. When appear the window as below, press the ‘Yes’ button. 

 
 
g. If appear the window as below, press the ‘OK’ button. 

It is completed to save the latest Measurement data of Body Composition. 

 
 

h. Doing ‘Transmit member’ of relevant member and measure body composition. When 
receive the measuring data, appear the window as below. Press the ‘Yes’ then the 
followings measurement data are uploaded to the connected Lifecorder. 

    
 

  i. When appear the window as below, click the ‘OK’ button. Then the data’s upload to the 
connected Lifecorder is over. 
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2) Connecting a using Lifecorder  
It means that one is connection of existing member after connecting with new Lifecorder and 
another is connection of using Lifecorder without using Body Pass program. 

  
① In case of connection of existing member after ‘1) Connecting new Lifecorder’  

a. If connect the Lifecorder as proceeding the Body Pass program, below windows are 
appeared continuously. After searching the member using the currently connected Lifecorder, 
download the data of Lifecorder automatically and upload the latest data of Body Composition 
Analyzer at the same time. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b. On above window, if 'Data download' show, press the 'Save' button and the information of 
Lifecorder is saved. The saved Lifecorder's information is indicating into the Result paper 
and Lifecorder data screen. 

 
c. Doing ‘Transmit member’ for the selected member and measure the Body Composition 

Analyzer. When receive the measurement data, appear the window as below. If press the 
‘yes’ button, the present measurement data, which is shown as follow window, are 
uploaded to the connected Lifecorder. 
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  d. When appear the window as below, click the ‘OK’ button. Then the data’s upload to the 
connected Lifecorder is over. 

 
 
 
② Using Lifecorder without registering the Body Pass program 

a. In case the user, who use the Lifecorder first without registering, connects the Lifecorder, if 
appear the window as below press the 'confirm' button. Member register is not done so 
register of member on main screen. (Refer to page 21 for Member Resistration) 

 
 
b. Dong ‘Transmit member’ to BCA and measure Body Composition. When receive the 

measuring data from Body Composition Analyzer, appear the window as below. Then press 
‘Yes’ button and current measurement data as below are uploaded to the currently 
connected Lifecorder. 

     
 
  c. When appear the window as below, click the ‘OK’ button. Then the data’s upload to the 

connected Lifecorder is over. 
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In order to print out with pre-formatted sheet, you must use as printer which we supply with 

main device. It is impossible to use the printer which customer has had already due to 

wrong printing position. 

9. Setting Result Sheet Print 
 

Click “Function → Selecting result sheet print” on the upper left side of the main screen then the 

window below appears. 

Choose the result sheet you want to see and click “Apply” button. 

 
 

1) Selecting result sheet type: choose general A4 paper printing or pre-formatted sheet printing. 

2) Selecting black and white/color: choose color printing or black and white printing. 

3) Selecting result sheet print: choose Body composition result sheet 1 or Lifecorder result 

sheet. 

4) Print position: It is possible to adjust print position to fit to the pre-formatted result sheet. 

There are two directions of up-down and left-right. 
 
 
 
 
 
 
 
 
 
 

Note 
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10. Saving Entire Member File 

 

This is to save the measured result of entire member as an excel file or a text file. 

Click “Function → Save entire member file” on the upper left side of the main screen then “Save 

entire member file” window appears. 

 
 

1) Search: choose “ID number” or “Measured date” and set search range then click “Search” 

button. The list of measured result appears in the table. 

 

2) Save file: this is to save the list as an excel file or 

a text file. 

① Click “Save file” button then the window on the 

right appears. 

② choose the file type you want and assign “File 

name” (basically the date_time of doing this job) 

and “File path” then click “Save” button. When 

the confirmation window for saving file appears, click “OK” to finish saving the file. 

 

3) Close: click “Close” button then the main screen appears. 
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11. Measured Result  

 

Click “Measure result” button in the main screen or double-click the member you want to see 

meaured result in the measurement list or entire member list then preview of the result sheet 

appears like the picture on the right. 

 

1) Function 

 

① Save image: this is to save the result sheet as a JPG file. 

Click “Save image” button then a pop up window appears like the picture on the right. 

“File name” (basically the date_time_ID number of doing this job) and “File path” can be 

assignd as you please. Click “Save” button to finish saving the image. 

 

② Print: this is to print the result sheet according to the setting for result sheet print. 

③ Close: click “Close” button then the main screen appears. 
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2) Result sheet view 
You can see Body composition result sheet1, Lifecorder result sheet using vertical tab. 
Lifecorder date specify 14days or 30day. And Lifecorder result changed according to specifying 
lifecorder date. 
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3) Lifecorder Result Sheet Display Conditions 

All of the data displayed in Lifecorder result sheet are based on the BCA Measurement date. 

And there should exist the data in Lifecorder on the Measurement date. 
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① Patient information : Name / ID / Height / Weight / Age / Gender 

 

② Logo image: display the Logo image 

 

③ Comparison   

 
▶ Period : show the periods of present and past on the basis of BCA Measurement date.  

(The period can be set to 14 or 30) 

▶ Average A.E.E. : display the average A.E.E. within the selected period from the 

measuremet date  

When calculating the average A.E.E.  

1. Exclude the first and last day since the Lifecorder data were generated (because the 

data do not cover 24 hours) 

2. Exclude those with less than 50 steps of the data within the period (close to no 

activities) 

▶ Achievement: (average A.E.E. ÷ target A.E.E. set in the Lifecorder) × 100 

Since the target A.E.E. can be set by the user, calculate the achievement with the one set 

at the last minute.  

▶ P.B.F.(Percent Body Fat) :   

Presentè Display the P.B.F. measured at the moment. 

Pastè Display the last data on P.B.F.of the past ones. 

       (If there is no measurement record in the past, it displays nothing.) 

 

④ Change in Body Composition 
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▶ Standard Graph: display values of each items on the basis of standard weight calculated 

from the measurement values at the moment.  

▶ Graph of the present: display each item’s values on the basis of the member’s weight at 

the moment. 

▶ Graph of the past: display each item’s values on the basis of the latest one among the 

past measurement data that are shown in the comparison of previous data column.  

(If there is no measurement record in the past, it displays nothing.) 

 

⑤ Pattern of Physical Activity(Maximum) / ⑥ Level of Physical Activity(Maximum) 

 
▶ Pattern of Physical Activity:  

Display the data of the day when the A.E.E. was the hightest in the 24 hour-based graph. 

The values of Steps / A.E.E. / T.E.E. / Activity min. are limited to the given day. 

When calculating the data of the day with the highest activities, 

1. Exclude the first and last day since the Lifecorder data were generated (because the 

data do not cover 24 hours) 

2. Exclude those with less than 50 steps of the data within the period (close to no activities) 

▶ Level of Physical Activity: Display the activity time of the day with the highest activity into 

each Activity Level. 

                                                   

⑦ Pattern of Physical Activity(Average) / ⑧ Level of Physical Activity(Average) 

 

Calculate the average A.E.E. within the current period and if there is no day or date with the 

corresponding value to the average amount, display the Pattern of Physical Activity and its 

levels of the day with the closest value(when there are more than 2 days with the close 

values, the latest day will be based).  
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  When calculating the average A.E.E. 

1. Exclude the first and last day since the Lifecorder data were generated (because the data 

do not cover 24 hours) 

2. Exclude those with less than 50 steps of the data within the period (close to no activities) 

 

⑨ Activity Energy Expenditure 

 
* Show the activity amount within the current period.  

* When there are data for 14 or above, the date displayed in the graph is a weekly basis.  

* The beginning and the last day as well as the day with 0 amount of exercise are also 

displayed. 

 

⑩ Steps 

 

* Show the numbers of steps within the current period. 

* When there are data for 14 or above, the date displayed in the graph is a weekly basis. 

* The beginning and the last day as well as the day with no step are also displayed. 
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12. Measured Result List  

 

Click “Measure list” button in the main screen then “Measured result list” screen appears. 

Or click a member in the right list of the main screen first and click “Measure list” button then the 

measured result list of the member appears. 

 

 

1) Search: choose “ID number” or “Measured date” and set search range then click “Search” 

button. The list of measured result appears in the table. 

 

2) Measure result: click the data you want to see in the list first and click “Measure result” 

button then preview of the result sheet appears. Or double-click the data then the preview 

screen appears. 

 

3) Save: this is to save the list as an excel file or a 

text file. 

① Click “Save file” button then the window on the      

right appears. 

② Choose the file type you want and assign “File 

name” (basically the date_time_ID number of 

doing this job) and “File path” then click “Save” 

button. When the confirmation window for saving file appears, click “OK” to finish saving the 

file. 
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4) Print: this is to print the list. 

① Click “Print” button then the window below appears. 

 
② Check the items you want to print. If you choose too many items, it becomes out of 

printable range and a window appears that informs you that selected items are too many to 

be printed. 

③ The items selected are printed by clicking “Print” button. 

④ This window is closed by clicking “Close” button. 

 

5) Delete: this is to delete the result you want to remove. 

 

6) Close: click “Close” button then the main screen appears. 
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13. Measured Result Graph  

 

Click the member you want to see measured result graph in the right list of the main screen or 

in the entire member list. Click “Measure graph” button in the main screen then measure graph 

screen appears like the picture below. 

 
 
1) Viewing Graph : If you select the measurement items and date from the results and press 

the ‘Viewing Graph’ button, you are presented with a graph that divided according to the 

selected items by means of ‘Tab’. Pressing each tab displays the corresponding graph. 

- When the graph is completely drawn, the ‘Print’ and ‘Save Image’ buttons are activated. 

- Right above the graph marked are the Maximum and Minimum values with the items under 

search over a given period. 

- Choosing other items in this same level, inactivates the buttons, ‘Print’ and ‘Save Image’. You 

must click the ‘Viewing Graph’ button again to view a new graph containing additional items 

and the ‘Print’ and ‘Save Image’ buttons are ready.  
- In case the measurement data pieces are 10 or less, the related dates are all presented. 

Otherwise, the dates are displayed on a weekly basis. 

 
2) Saving Image : Pressing the ‘Saving Image’ button enables saving of the graph as an image 

file. After pressing the button and selecting the location to save, you can save the graphs with 

BMP file extentions for each items chosen to be printed out.  

 Graphs are included in one image and when the entire 7 items are selected a total of 3 

images are saved. For the file name, ‘First-, Second -, Third –’ is automatically attached to 

the head of each name of files to be saved.  
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3) Print 

Upon pressing the ‘Print’ button, a message shows reading “Do you want to print out the 

selected items?” If you select the “OK” button, the printer prints out them on a page with 3 

graphs on it. The contents printed are the same as the saved.  

 

4) Close: click “Close” button then the main screen appears. 

 
 
 
 

 
 
 
On the main screen, choose the member who you want to know the Lifecorder result and press 
the 'Lifecorder data' button (                 ) then you can see the Lifecorder data. 
 

 
 
 
 
 
 
 
 
1) There is Lifecorder ID, Date, Time, target AEE, Week day, DEE, AEE, and step count for 

selected member 
 
2) For more details information Check the ‘Detail View’.  

You can have additional data such as intensity of each step, micro movement, and input time 
of event, etc.  
 

3) Save: this is to save the list as an excel file or a text 

file. 

① Click “Save file” button then the window on the      

right appears. 

② Choose the file type you want and assign “File      

name” (basically the date_time_ID number of doing  

this job) and “File path” then click “Save” button.      

When the confirmation window for saving file appears, click “OK” to finish saving the file.

14. How to See the Lifecorder data 
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15. Checking Program Version 

 

1) When you check the version of Body Pass program currently used, click “Body Pass program 

→ Program information” then the program version window appears like the picture below. 

 
 

2) The version is also presented at the left bottom of the main screen. 
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16. Exiting BodyPass Program  

 

Body Pass program is closed by clicking Exit button in the main screen. 

 
 


